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RX72M グループ 
通信ボード EtherCAT スタートアップマニュアル 

要旨 

本書は、産業ネットワーク評価用 RX72M 通信ボードで EtherCAT®通信を行うためのクイックスタートガ

イドです。 

 

対象デバイス 

RX72M 

  



RX72M グループ 通信ボード EtherCAT スタートアップマニュアル 

R01AN4672JJ0106  Rev.1.06  Page 2 of 28 
2025.5.23  

目次 

1. 動作環境 ........................................................................................................................... 3 

2. 通信ボードの設定と接続 .................................................................................................. 4 
2.1 通信ボードの設定 ......................................................................................................................... 4 
2.2 電源の選択 .................................................................................................................................... 5 
2.3 通信ボードの接続 ......................................................................................................................... 5 

3. e2studio のインストール ................................................................................................. 6 
3.1 CC-RX コンパイラ V3.05.00 インストール ................................................................................. 6 
3.2 インストールされたコンパイラの確認方法 ................................................................................. 6 

4. 接続 .................................................................................................................................. 8 

5. EtherCAT スレーブスタックコードをサンプルプログラムにインポート ........................ 9 

6. EtherCAT FIT モジュールを e2studio にインポート ..................................................... 11 

7. サンプル・プロジェクトを e2studio にインポート ........................................................ 12 

8. プログラミングとデバッグ ............................................................................................ 13 

9. TwinCAT との接続 ........................................................................................................ 16 
9.1 ESI ファイルの準備 .................................................................................................................... 16 
9.2 TwinCAT の起動 ......................................................................................................................... 16 
9.3 ネットワークのスキャン ............................................................................................................ 16 
9.4 SII EEPROM の書き込み ............................................................................................................ 17 
9.5 デバイスの再スキャン ................................................................................................................ 17 
9.6 I/O 動作確認 ................................................................................................................................ 17 

10. Appendix IAR プロジェクトへのコンバート手順 .......................................................... 18 

11. Appendix e2studio 設定情報 ........................................................................................ 25 
11.1 FIT モジュール構成 ..................................................................................................................... 25 
11.2 コンフィグレーションオプション .............................................................................................. 25 
11.3 端子設定 ...................................................................................................................................... 26 
11.4 ビルド構成 .................................................................................................................................. 27 
11.5 デバッグ構成 ............................................................................................................................... 27 

改訂記録 ................................................................................................................................ 28 
 



RX72M グループ 通信ボード EtherCAT スタートアップマニュアル 

R01AN4672JJ0106  Rev.1.06  Page 3 of 28 
2025.5.23  

1. 動作環境 
本マニュアルのサンプルプログラムは、下記の環境を想定しています。 

 

表 1.1-1 動作環境 
項目 内容 

使用ボード テセラ・テクノロジー社製 RX72M 通信ボード 
型名：TS-RX72M-COM 

CPU RX CPU (RXv3) 
動作周波数 CPU クロック (CPUCLK)：240MHz  
動作電圧 3.3V 
動作モード シングルチップモード 

ブートモード(SCIインタフェース) 
ブートモード(USBインタフェース) 
ブートモード(FINE インタフェース) 

使用デバイス R5F572MNDDBD 
・コードフラッシュメモリ 

容量：4Mバイト 
ROM キャッシュ：8K バイト 

・データフラッシュメモリ 
容量：32K バイト 

・RAM / 拡張 RAM 
512K バイト/ 512K バイト 

通信プロトコル EtherCAT 
統合開発環境 CCRX コンパイラ(V3.05.00 以降) + e2studio(2025-04 以降) 

IAR Embedded Workbench for Renesas RX (V5.10.1 以降) 
Smart Configurator for RX (V2.19.0 以降) 

エミュレータ ルネサスエレクトロニクス 製 
E2 Lite 

SSC Tool EtherCAT Technology Group (ETG) 提供 
Slave Stack Code (SSC) Tool Version 5.13 以降 

ソフトウェア PLC Beckhoff Automation 製 
TwinCAT® 3 (Beckhoff web サイトからダウンロード) 

 

なお、SSC Tool、ソフトウェア PLC のインストールは完了しているものとします。 
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2. 通信ボードの設定と接続 
ボードの詳細情報に関しては、「RX72M 通信ボード ハードウエアマニュアル」をご参照ください。 

 

図 1-1 RX72M 通信ボード構成 

 

 

2.1 通信ボードの設定 
ボードの電源投入前に、ジャンパの設定を行い、各ケーブルを接続します。JTAG の Configuration モード

の設定を行います。通常はジャンパーピンの 2-3 ショートにて使用します。 ホットプラグイン機能を使用

する場合は 1-2 ショートに変更して使用します。 
関連する部品の詳細位置に関しては、[RX72M 通信ボードハードウエアマニュアル]をご参照ください。 

 

図 1-2 ジャンパーピン設定 
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2.2 電源の選択 
本ボードは DC Jack または USB より、DC5V を入力し RX72M 用の電源の供給が可能です。どちらか

を選択して動作環境を構築してください。 
 

 

2.3 通信ボードの接続 
以下のように、各ケーブルを接続してください。 
 
(1) Ethernet ケーブル（カテゴリー５以上を推奨）を Ether ポート（CN2 IN）に接続。 

 
(2) ICE の JTAG コネクタを JTAG Connector に接続し、ホストコンピュータと USB 接続。 

 
(3) DC Jack または USB より、DC5V を接続し、電源を投入。 
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3. e2studio のインストール 
以下の web サイトから、RX72M 対応の e2studio(2023-10 以降)をダウンロードしてください。 

https://www.renesas.com/e2studio_download 

 

3.1 CC-RX コンパイラ V3.05.00 インストール 
e2studio のインストール中にデバイス・ファイリ選択画面が現れます。[RX]を選択してインストールするこ

とで、RX72M 対応の CC-RX V3.05.00 コンパイラが合わせてインストールされます。 

 

 

3.2 インストールされたコンパイラの確認方法 
(1) Windows の [スタート] メニューから e2studio を起動します。 

 
(2) [ファイル]→[新規]→[C/C++ Project]→[次へ]を選択します。 

 

  

https://www.renesas.com/e2studio_download
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(3) [Templates for New C/C++ Project]ダイアログで[Renesas RX]→[Renesas CC-RX C/C++ Executable 

Project]→[次へ]を選択します。 

 

 

(4) [New Renesas CC-RX C/C++ Executable Project]ダイアログで任意のプロジェクト名を入力し[次へ]
を選択します。 

 
(5) [Select toolchain, device & debug settings]ダイアログで[Toolchain Settings]欄の[ツールチェーンの管

理]を選択します。 
 

(6) [Renesas ツールチェーン管理]ダイアログで”Renesas CCRX”に”v3.05.00”が追加されていれば OK で

す。 
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4. 接続 
 
(1) LAN ケーブルは”CN2 IN”側に接続してください。 

 
(2) E2 エミュレータ Lite をユーザインタフェースケーブルにて通信ボードの JTAG コネクタに接続して

ください。 
 
(3) E2 エミュレータ Lite をコンピュータの USB ポートに接続します。E2 エミュレータ Lite

の”ACT”LED が点滅します。 
 
(4) “新しいハードウェアの検出”ウイザードが表示されますので、以下の手順に従って、ドライバをイン

ストールしてください。WindowsTM 7/8/8.1 の場合、管理者権限が必要です。 
WindowsTM 7/8/8.1：インストールが完了すると Windows タスクバーに完了通知されます。 
WindowsTM 10：Windows タスクバーにデバイス設定のボタンが表示され自動インストールされます 

 
(5) 通信ボードに電源を供給してください。 
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5. EtherCAT スレーブスタックコードをサンプルプログラムにインポート 
*本サンプル・プロジェクトには EtherCAT スレーブスタックコードは同梱されていません。 
*EtherCAT スレーブスタックコードの生成には”EtherCAT Slave Stack Code(SSC) Tool”が必要です。 
*SSC Tool は ETG 協会から入手可能です。 
 
サンプルプログラムは"ecat_demo_comrx72m.zip"の形式で提供されますので、予め任意のフォルダに解凍

してください。 
 

(1) Windows スタートメニューから[EtherCAT Slave Stack Code]→[SSC Tool]をクリックして SSC Tool
を起動します。 

 
(2) [New Project]ダイアログで[Import]をクリックし、サンプルプログラムフォルダにある下記の SSC 

Tool コンフィグレーションファイルを選択して[OK]をクリックします。 
ecat_demo_comrx72m¥utilities¥ssc_config¥ Renesas_RX72M_config.xml 
 

(3) [Custom]チェックボックスをチェックしてリストから”Renesas RX72M <Renesas Electronics 
Corp>”を選択し[OK]をクリックします。 

 

 

(4) [File]→[Save]をクリックし、任意のプロジェクトファイル名でプロジェクトを保存してください。

(デフォルトでは” RX72M EtherCAT.esp”となります) 
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(5) [Project]→[Create New Slave Files]をクリック[Current new Slave Files]ダイアログで[Start]をクリッ

クします。 

 

 

(6) ソースコードが生成され、成功すると”New Files created successfully”と表示されるので[OK]をク

リックします。 
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(7) EtherCAT アプリケーションのソースフォルダに、生成した EtherCAT スレーブスタックコードを移

動してください。 
 
移動元フォルダ： 
ecat_demo_comrx72m¥utilities¥ssc_config¥Src 
 
移動先フォルダ： 
ecat_demo_comrx72m¥project¥src¥application¥ecat¥beckhoff 

 
 
 

6. EtherCAT FIT モジュールを e2studio にインポート 
EtherCAT FIT モジュールは RX Driver パッケージに含まれていないためサンプルプロジェクト以外でス

マートコンフィグレータのソフトウェアコンポーネントとして利用する場合は手動で e2 studio に組み込む

必要があります。 
 
詳細は、”r01an4881xx0132-rx-ecat.pdf“の 6.2 章を予め参照して、モジュールを組み込んでください。 
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7. サンプル・プロジェクトを e2studio にインポート 
(1) [ファイル]→[インポート]をクリックします。 
 
(2) [選択]ダイアログで[一般]→[既存プロジェクトをワークスペースへ]を選択し[次へ]をクリックしま

す。 

 

 
(3) [プロジェクトのインポート]ダイアログの[ルート・ディレクトリの選択]チェックボックスを選択し、

[参照]をクリックします。 
 
(4) 通信ボード用サンプル・プロジェクトである”ecat_demo_comrx72m”を選択して[開く]をクリックし

ます。 

 

 
 

(5) [プロジェクト]の”ecat_demo_comrx72m”をチェックし[次へ]をクリックするとプロジェクトがイン

ポートされます。 
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8. プログラミングとデバッグ  
(1) プロジェクト・エクスプローラーで“ecat_demo_comrx72m.scfg”をダブルクリックし、 

 [コードの生成]を実行します。 

 

 
 

(2) プロジェクト・エクスプローラーで“ecat_demo_comrx72m”プロジェクトを左クリックし、   

[プロジェクトのビルド] を選択して、ビルドを実行します。 

 

 
 
  



RX72M グループ 通信ボード EtherCAT スタートアップマニュアル 

R01AN4672JJ0106  Rev.1.06  Page 14 of 28 
2025.5.23  

 
(3) ビルドが完了したら、[デバッグ]ボタンから、[デバッグ構成]を選択します。 

 

 
 

(4) “ecat_demo_comrx72m Hardware Debug”をクリックしてターゲットにプログラムをダウンロード

し、デバッグボタンを押して開始します。  
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(5) 'e2-server-gdb.exe'のファイアウォール警告が表示されることがあります。 [自宅や職場のネット

ワークなどのプライベートネットワーク]のチェックボックスをチェックにして、<アクセスを許可>
をクリックします。  

 
(6) ユーザーアカウント制御（UAC）ダイアログが表示されることがあります。 管理者パスワードを入

力して、 [はい]をクリックします。  
 

(7) パースペクティブ切り替えの確認ダイアログにてパースペクティブの変更を勧めるダイアログが表

示される場合は「常にこの設定を使用する」チェックボックスにチェックし、[はい]をクリックしま

す。  
 

(8) E2 Lite デバッガの緑色の「ACT」LED が常に点灯します。  
 

(9) コードをダウンロードしたら、<再開>ボタンをクリックして、メイン関数 main（）の最初の行ま

でコードを実行します。 もう一度<再開>ボタンをクリックすると、残りのコードでターゲットが実

行されます。 
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9. TwinCAT との接続 
TwinCAT3 を使用してサンプルプログラムを操作する方法について説明します。 
 
 

9.1 ESI ファイルの準備 
TwinCAT を起動する前にサンプルプログラムに含まれている ESI ファイルを TwinCAT の所定の場所

(¥TwinCAT¥3.x¥Config¥IO¥EtherCAT)にコピーしてください。  

 
ecat_demo_comrx72m¥utilities¥esi¥ Renesas EtherCAT RX72M.xml 

 
 

9.2 TwinCAT の起動 
(1) スタートメニューから、[Beckhoff] → [TwinCAT3] → [TwinCAT XAE (VS20xx)]を選択 します。 
 
(2) プログラム起動後、[File] → [New] → [Project] として、TwinCAT XAE Project タイプの新規プロ

ジェクトを作成してください。 
 
 

9.3 ネットワークのスキャン 
(1) システムマネージャツリーで[I/O]→[Devices]を右クリックし、[Scan]を選択します。 
 
(2) [HINT：Not all types of devices can be found automatically]ダイアログで[OK]をクリックします。 
 
(3) [new I/O devices found]ダイアログでスキャンを行うイーサネットアダプタのチェックボックスを選

択し[OK]をクリックします。 
 
(4) [Scan for Boxes]ダイアログで[Yes]をクリックするとスキャンが始まり、EtherCAT セグメント内の

デバイスが自動認識されます。 
 
(5) ”Active Free Run”ダイアログが表示されるので[Yes]をクリックします。 

システムマネージャツリーで“I/O”→”Devices”の下に”Device 1 ”→”Box 1 ” 
のように Box が追加されていれば正常です。 
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9.4 SII EEPROM の書き込み 
*通信ボードは出荷時に EEPROM がブランクになっていますので書き込みを必ず実施してください。 
*EEPROM の書き込みを行っている場合は本節の処理は不要です。 
 
EEPROM がブランクの場合、システムマネージャツリーには”Box1 (PFFFFFFFF RFFFFFFFF)”のように

表示されます。 
 
(1) システムマネージャツリーで [Box 1]をダブルクリックすると、右側にパネルが表示されます。  
 
(2) [EtherCAT]タブを選択し [Advanced Settings]のボタンをクリックします。 
 
(3) [Advanced Settings]ダイアログの左ツリーで[ESC Access] → [EEPROM] → [Hex Editor]を選択しま

す。 
(4) [Hex Editor]ダイアログで“Download from list”を選択します。  
 
(5) [Write EEPROM]ダイアログで[Renesas Electronics Corp.] → [Renesas RX72M Group] → 

[Renesas EtherCAT RX72M]] を選択し[OK]をクリックします。EEPROM が書き込まれます。 
 
(6) 書き込み後は通信ボードを再起動し（電源再投入またはリセット）、書き換えたデータがマイコンの

動作に反映されるようにしてください。  
 
 

9.5  デバイスの再スキャン 
(1) [Restart TwinCAT (Config Mode)]ボタンを押します。 
 
(2) [Restart TwinCAT Sysytem in Config Mode]ダイアログで[OK]をクリックします。 
 
(3) [Load I/O Devices]ダイアログで[Yes]をクリックします。 
 
(4) [Active Free Run]ダイアログで[Yes]をクリックします。 

システムマネージャツリーの”Box1 が”Box1(Renesas EtherCAT RX72M)”になっていれば OK です。 
 
 

9.6 I/O 動作確認 
(1) システムマネージャツリーで“Box 1”をダブルクリックすると、右側にパネルが表示されます。  
 
(2) “Online”タブを選択し、”Current Status”が”OP”になっていることを確認します。 
  
(3) システムマネージャツリーで“Box 1”左横の＋を展開します。 
 
(4) “TxPDO-Map”→”InputCounter”を選択し、右側パネルの”Online”タブを選択すると"Value"が表示され

ます。 
DIP SW5 で設定した値になっていることを確認してください。 

 
(5) システムマネージャツリーで“RxPDO-Map”→”OutputCounter”を選択し、右側パネルの”Online”タブを

選択すると"Value"が表示されます。 
"0"が表示されていることを確認してください。 

 
(6) [Write]をクリックし”Set Value Dialog”ダイアログで任意の数値を入力してください。 
 
(7) ｢OK｣をクリックし、"Value"の表示が入力した値になっていることを確認してください。 

入力した値の下位 4 ビットが 通信ボードの LED4-1 に表示されます。(bit=1 のとき LED 点灯)  
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10. Appendix IAR プロジェクトへのコンバート手順 
IAR システムズの web サイトから、RX72M 対応の IAR Embedded Workbench for Renesas RX(V5.10.1 以

降)をダウンロード、インストールしてください。 
https://www.iar.com/jp/ 

 
また、以下の web サイトから Smart Configurator for RX (V2.19.0 以降) をダウンロード、インストールし

てください。 
  https://www.renesas.com/jp/ja/software-tool/rx-smart-configurator 
 
以下に e2studio 版のプロジェクトから、IAR プロジェクトへのコンバートする手順を記載します。 
 

(1) IAR Embedded Workbench for Renesas RX を起動します。 
 

(2) “ツール >> Convert To IAR for RX…”をクリックします。  
 

(3) Root directory of source project で e2studio 版サンプルプログラムディレクトリ

の ”ecat_demo_comrx72”を選択します。  
 

(4) Project file conversion で”Enable”のチェックボックスを選択します。  
 

(5) Project type で”Renesas e2studio for RX”を選択します。  
 

(6) Source code substitution で”Enable”のチェックボックスのチェックを外します。 
  

(7) “Execute”をクリックします。  

 

 
 

https://www.iar.com/jp/
https://www.renesas.com/jp/ja/software-tool/rx-smart-configurator
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(8) Choose destination directory のウィンドウで” Operate on a copy of the source code in the following 

directory”のチェックボックスを選択します。 コピー先のディレクトリは自由に選択してください。 

 

 
(9) Report のウィンドウで”OK”をクリックします。  

 

IAR Embedded Workbench for Renesas RX は起動したままにしてください。 
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(10) 次に Smart Configurator for RX を起動します。 

EtherCAT FIT モジュールは RX Driver パッケージに含まれていないため、初めて起動する場合は手

動で Smart Configurator for RX に組み込む必要があります。 
詳細は、”r01an4881xx0132-rx-ecat.pdf“の 6.3 章を参照して、モジュールを組み込んでください。 

 
(11) “ファイル” >>“開く”で(8)のコピー先ディレクトリにある iccrx_ecat_demo_comrx72m.scfg を選

択します。 

 

 
(12) コンフィグレーション・ウィンドウが表示されたら“コードの生成”を実行します。 

Smart Configurator for RX は終了して構いません。 
 

(13) IAR Embedded Workbench for Renesas RX で“ファイル” >> “ワークスペースを開く”をクリックし、

コピー先ディレクトリにある IAR プロジェクトの.eww ファイルを開きます。  
 

(14) “プロジェクト” >> “プロジェクトコネクションの追加”をクリックします。 
使用するコネクションは”IAR Project Connection File”を選択し”OK”をクリックします。 
buildinfo.ipcf を選択して”開く”をクリックします。 
Smart Configurator for RX でコード生成したファイルがインポートされます。 
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(15) プロジェクト上で右クリックをして、”オプション”をクリックします。  

 
(16) 一般オプションタブの”ターゲット”を選択します。  

 
(17) “使用するデバイス”を選択します。 RX72M の場合は”R5F572MN_DUAL”です。 
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(18) C/C++ コンパイラタブの”プリプロセッサ”を選択し、CCRX プロジェクトと同じインクルードパスを

設定します。  

 

 

プロジェクトのディレクトリに合わせて¥src 以下を設定してください。 

$PROJ_DIR$¥src¥application¥ecat¥beckhoff¥Src 

$PROJ_DIR$¥src¥application¥ecat¥renesas 
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(19) リンカタブの”設定”を選択します。リンカ設定ファイルで”デフォルトのオーバライド”のチェック

ボックスを設定します。次に”ターゲットデバイスの.icf ファイル”を選択します。 RX72M は” 
lnkrx700.icf”を設定してください。 
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(20) デバッガのタブの”設定”を選択します。                            

ドライバで”エミュレータ”を選択します。RX72M は”E2 Lite/EZ-CUBE2”です。    

デバイス記述ファイルで”デフォルトのオーバライド”を選択します。RX72M は”ior5f572mn_dual.ddf”
です。 

 

 
 

(21) “プロジェクト >> すべてを再ビルド”をクリックします。  
 

(22) “E2/E2 Lite >> ハードウェア設定”をクリックします。  
 

(23) ハードウェア設定ウィンドウで”MCU”タブの下記項目を設定し、OK をクリックします。 
入力クロックをチェックし周波数を 24MHz に設定 

  
(24) “プロジェクト >> ダウンロードしてデバック”をクリックします。  
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11. Appendix e2studio 設定情報 
サンプルプログラムを構成するための e2studio の設定について説明します。 

新規プロジェクトを作成しサンプルプログラムの機能を追加する際の参考にしてください。 

11.1 FIT モジュール構成 
サンプルプログラムは以下の FIT モジュールで構成されています。 

表 10-1 FIT モジュール構成 

種類 モジュール名 FITモジュール名 
Board Support 
Package 

ボードサポートパッケージ(BSP) r_bsp 

Device Driver コンペアマッチタイマ(CMT) r_cmt_rx 
Device Driver シリアルコミュニケーションインターフェース

(SCI) 
r_sci_rx 

Middleware バイト型キューバッファ（BYTEQ） r_byteq 
Device Driver EtherCAT r_ecat_rx 
 

11.2 コンフィグレーションオプション 
サンプルプログラムを構成するモジュールのコンフィグレーションファイルと EtherCAT アプリケーショ

ンの入出力端子定義を変更しています。 コンフィグレーションオプションの変更箇所を以下に示します。 

 

 EtherCAT FIT モジュールの設定変更 

使用する PHY LSI を通信ボードに搭載されている KSZ8081MNX にします。 

また PHY のリセットウエイト時間を 500μs に設定します。 

【 r_config/r_ecat_rx_config.h 】 
マクロ名 設定値 

ECAT_CFG_USE_SUPPORTED_PHY 2 
ECAT_CFG_PHY_DELAY_RESET 500 

 

 SCI FIT モジュールの設定変更 

CH6 と送信完了割込みを有効にする設定にします。 

【 r_config/r_sci_rx_config.h 】 
マクロ名 設定値 

SCI_CFG_CH6_INCLUDED 1 
SCI_CFG_TEI_INCLUDED 1 

 

 EtherCAT アプリケーションの設定変更 
DIP SW 入力と LED 出力端子の割当てを通信ボード向けに設定します。 

【 application/ecat/sampleappl.c 】 
マクロ名 設定値 

APPL_CFG_LED_SW 2 
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11.3 端子設定 
サンプルプログラムを通信ボードで動かすための端子設定をインポートすることができます。 

スマートコンフィグレータの[端子]タブで[端子機能の配置をインポート]ボタンをクリック

し、”ecat_demo_comrx72m_board.xml”を選択してください。 

xml ファイルはサンプルプログラムに含まれています。 

 

 

FIT モジュールで使用する端子をスマートコンフィグレータの[コンポーネント]タブの[リソース]プロパ

ティで有効にします。 

 

コンポーネント 有効にするリソース 有効にする端子 

r_ecat_rx ESC 

ESC_MII0 

ESC_MII1 

全端子 

r_sci_rx SCI6 RXD6/SMISO6端子 

TXD6/SMOSI6端子 
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11.4 ビルド構成 
サンプルプログラムをビルドする際の設定を示します。 

 

表 10-2 ツール設定タブ 

項目 変更内容 説明 

Compiler  

- ソース 

「インクルード・ファイル・ディレ

クトリ」にインクルードパスを追

加 

各 FIT モジュールで設定が必要なインクルードパス 

を追加します。「FIT Configurator」を使用して、各 
FIT モジュールを組み込む場合は、自動で設定され

ます。 

サンプルプログラムのインクルードパスを追加しま

す。本プロジェクトで

は”application¥ecat¥beckhoff¥Src”
と”application¥ecat¥renesas”を追加しています。 

 <設定例> 

Compiler  

– 最適化 

最適化レベルを変更 

レベル1：一部最適化を実施する 

SSCが生成するコードの一部が最適化によりビルド

されないことを防ぐため、最適化レベルを1に設定し

ています。 

 

11.5 デバッグ構成 
サンプルプログラムを通信ボードでデバッグする際の設定を示します。 

 

表 10-3 デバッグ構成 

タブ項目 変更内容 説明 

Debugger – 
Connection 
Settings 

EXTAL周波数を24MHzに設定、またエミュレーターからの

電源を供給しない設定にします。 

＜設定＞ 
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改訂記録 

Rev. 発行日 
改訂内容 

ページ ポイント 
1.00 2019.11.1 - 初版発行 
1.01 

 
2020.4.30 

 
3 「表 1.1 動作環境」に「IAR Embedded Workbench for Renesas 

RX」を追加 
11 5.(7) EtherCAT スレーブスタックコードの移動先フォルダを変更 

18-24 「9.Appendix IAR プロジェクトへのコンバート手順」を追加 
1.02 2020.8.31 22 手順(15) インクルードパスを変更 
1.03 2021.08.31 プログラム EtherCAT FIT モジュール バージョン 1.20 に対応 

25-27 「10.Appendix e2studio 設定情報」を追加 
1.04 2023.01.31 プログラム EtherCAT FIT モジュール バージョン 1.30 に対応 

SSC 関連ファイルとプロジェクト関連ファイルを分けるため

utilities フォルダと project フォルダを追加 
e2 studio 64 ビット版に対応 
SSC 5.13 に対応 

9, 11, 15, 27 フォルダ構成変更に伴いフォルダ名を変更 
22, 25 r_sys_time_rx モジュールは使用しなくなった為 FIT モジュール構

成から削除 
1.05 2023.11.30 プログラム CTT V2.4.0 に対応するために ESI ファイルを修正 

18-24 「10.Appendix IAR プロジェクトへのコンバート手順」を変更 
3 「表 1.1 動作環境」に「Smart Configurator for RX」を追加 

3, 6, 7, 18 各ツールのバージョンを更新 
1.06 2025.5.23 プログラム EtherCAT FIT モジュール バージョン 1.32 に対応 

 
 

 



 

 

製品ご使用上の注意事項 
ここでは、マイコン製品全体に適用する「使用上の注意事項」について説明します。個別の使用上の注意事項については、本ドキュメントおよびテク

ニカルアップデートを参照してください。 

1. 静電気対策 

CMOS 製品の取り扱いの際は静電気防止を心がけてください。CMOS 製品は強い静電気によってゲート絶縁破壊を生じることがあります。運搬や保

存の際には、当社が出荷梱包に使用している導電性のトレーやマガジンケース、導電性の緩衝材、金属ケースなどを利用し、組み立て工程にはアー

スを施してください。プラスチック板上に放置したり、端子を触ったりしないでください。また、CMOS 製品を実装したボードについても同様の扱

いをしてください。 

2. 電源投入時の処置 

電源投入時は、製品の状態は不定です。電源投入時には、LSI の内部回路の状態は不確定であり、レジスタの設定や各端子の状態は不定です。外部

リセット端子でリセットする製品の場合、電源投入からリセットが有効になるまでの期間、端子の状態は保証できません。同様に、内蔵パワーオン

リセット機能を使用してリセットする製品の場合、電源投入からリセットのかかる一定電圧に達するまでの期間、端子の状態は保証できません。 

3. 電源オフ時における入力信号 

当該製品の電源がオフ状態のときに、入力信号や入出力プルアップ電源を入れないでください。入力信号や入出力プルアップ電源からの電流注入に

より、誤動作を引き起こしたり、異常電流が流れ内部素子を劣化させたりする場合があります。資料中に「電源オフ時における入力信号」について

の記載のある製品は、その内容を守ってください。 

4. 未使用端子の処理 

未使用端子は、「未使用端子の処理」に従って処理してください。CMOS 製品の入力端子のインピーダンスは、一般に、ハイインピーダンスとなっ

ています。未使用端子を開放状態で動作させると、誘導現象により、LSI 周辺のノイズが印加され、LSI 内部で貫通電流が流れたり、入力信号と認識

されて誤動作を起こす恐れがあります。 

5. クロックについて 

リセット時は、クロックが安定した後、リセットを解除してください。プログラム実行中のクロック切り替え時は、切り替え先クロックが安定した

後に切り替えてください。リセット時、外部発振子（または外部発振回路）を用いたクロックで動作を開始するシステムでは、クロックが十分安定

した後、リセットを解除してください。また、プログラムの途中で外部発振子（または外部発振回路）を用いたクロックに切り替える場合は、切り

替え先のクロックが十分安定してから切り替えてください。 

6. 入力端子の印加波形 

入力ノイズや反射波による波形歪みは誤動作の原因になりますので注意してください。CMOS 製品の入力がノイズなどに起因して、VIL（Max.）か

ら VIH（Min.）までの領域にとどまるような場合は、誤動作を引き起こす恐れがあります。入力レベルが固定の場合はもちろん、VIL（Max.）から VIH

（Min.）までの領域を通過する遷移期間中にチャタリングノイズなどが入らないように使用してください。 

7. リザーブアドレス（予約領域）のアクセス禁止 

リザーブアドレス（予約領域）のアクセスを禁止します。アドレス領域には、将来の拡張機能用に割り付けられている リザーブアドレス（予約領

域）があります。これらのアドレスをアクセスしたときの動作については、保証できませんので、アクセスしないようにしてください。 

8. 製品間の相違について 

型名の異なる製品に変更する場合は、製品型名ごとにシステム評価試験を実施してください。同じグループのマイコンでも型名が違うと、フラッ

シュメモリ、レイアウトパターンの相違などにより、電気的特性の範囲で、特性値、動作マージン、ノイズ耐量、ノイズ幅射量などが異なる場合が

あります。型名が違う製品に変更する場合は、個々の製品ごとにシステム評価試験を実施してください。 
 
 
 
 ○Arm® およびCortex® は、Arm Limited（またはその子会社）のEUまたはその他の国における登録商標で

す。 All rights reserved.  
○Ethernetおよびイーサネットは、 富士ゼロックス株式会社の登録商標です。 
○IEEEは、the Institute of Electrical and Electronics Engineers, Inc. の登録商標です。 
○TRONは”The Real-time Operation system Nucleus”の略称です。 
○ITRONは”Industrial TRON”の略称です。 
○μITRONは”Micro Industrial TRON”の略称です。 
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○EtherCAT® ,およびTwinCAT®は、ドイツBeckhoff Automation GmbHによりライセンスされた特許取得済

み技術であり登録商標です。  
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© 2025 Renesas Electronics Corporation. All rights reserved. 

ご注意書き 
1. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説明するものです。お客様の機器・システ

ムの設計において、回路、ソフトウェアおよびこれらに関連する情報を使用する場合には、お客様の責任において行ってください。これらの使用に

起因して生じた損害（お客様または第三者いずれに生じた損害も含みます。以下同じです。）に関し、当社は、一切その責任を負いません。 
2. 当社製品、本資料に記載された製品デ－タ、図、表、プログラム、アルゴリズム、応用回路例等の情報の使用に起因して発生した第三者の特許権、

著作権その他の知的財産権に対する侵害またはこれらに関する紛争について、当社は、何らの保証を行うものではなく、また責任を負うものではあ

りません。 
3. 当社は、本資料に基づき当社または第三者の特許権、著作権その他の知的財産権を何ら許諾するものではありません。 
4. 当社製品を、全部または一部を問わず、改造、改変、複製、リバースエンジニアリング、その他、不適切に使用しないでください。かかる改造、改

変、複製、リバースエンジニアリング等により生じた損害に関し、当社は、一切その責任を負いません。 
5. 当社は、当社製品の品質水準を「標準水準」および「高品質水準」に分類しており、各品質水準は、以下に示す用途に製品が使用されることを意図

しております。 
 標準水準： コンピュータ、OA 機器、通信機器、計測機器、AV 機器、家電、工作機械、パーソナル機器、産業用ロボット等 
 高品質水準： 輸送機器（自動車、電車、船舶等）、交通制御（信号）、大規模通信機器、金融端末基幹システム、各種安全制御装置等 
当社製品は、データシート等により高信頼性、Harsh environment 向け製品と定義しているものを除き、直接生命・身体に危害を及ぼす可能性のあ

る機器・システム（生命維持装置、人体に埋め込み使用するもの等）、もしくは多大な物的損害を発生させるおそれのある機器・システム（宇宙機

器と、海底中継器、原子力制御システム、航空機制御システム、プラント基幹システム、軍事機器等）に使用されることを意図しておらず、これら

の用途に使用することは想定していません。たとえ、当社が想定していない用途に当社製品を使用したことにより損害が生じても、当社は一切その

責任を負いません。 
6. 当社製品をご使用の際は、最新の製品情報（データシート、ユーザーズマニュアル、アプリケーションノート、信頼性ハンドブックに記載の「半導

体デバイスの使用上の一般的な注意事項」等）をご確認の上、当社が指定する最大定格、動作電源電圧範囲、放熱特性、実装条件その他指定条件の

範囲内でご使用ください。指定条件の範囲を超えて当社製品をご使用された場合の故障、誤動作の不具合および事故につきましては、当社は、一切

その責任を負いません。 
7. 当社は、当社製品の品質および信頼性の向上に努めていますが、半導体製品はある確率で故障が発生したり、使用条件によっては誤動作したりする

場合があります。また、当社製品は、データシート等において高信頼性、Harsh environment 向け製品と定義しているものを除き、耐放射線設計を

行っておりません。仮に当社製品の故障または誤動作が生じた場合であっても、人身事故、火災事故その他社会的損害等を生じさせないよう、お客

様の責任において、冗長設計、延焼対策設計、誤動作防止設計等の安全設計およびエージング処理等、お客様の機器・システムとしての出荷保証を

行ってください。特に、マイコンソフトウェアは、単独での検証は困難なため、お客様の機器・システムとしての安全検証をお客様の責任で行って

ください。 
8. 当社製品の環境適合性等の詳細につきましては、製品個別に必ず当社営業窓口までお問合せください。ご使用に際しては、特定の物質の含有・使用

を規制する RoHS 指令等、適用される環境関連法令を十分調査のうえ、かかる法令に適合するようご使用ください。かかる法令を遵守しないことに

より生じた損害に関して、当社は、一切その責任を負いません。 
9. 当社製品および技術を国内外の法令および規則により製造・使用・販売を禁止されている機器・システムに使用することはできません。当社製品お

よび技術を輸出、販売または移転等する場合は、「外国為替及び外国貿易法」その他日本国および適用される外国の輸出管理関連法規を遵守し、そ

れらの定めるところに従い必要な手続きを行ってください。 
10. お客様が当社製品を第三者に転売等される場合には、事前に当該第三者に対して、本ご注意書き記載の諸条件を通知する責任を負うものといたしま

す。 
11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを禁じます。 
12. 本資料に記載されている内容または当社製品についてご不明な点がございましたら、当社の営業担当者までお問合せください。 
注 1. 本資料において使用されている「当社」とは、ルネサス エレクトロニクス株式会社およびルネサス エレクトロニクス株式会社が直接的、間接的

に支配する会社をいいます。 
注 2. 本資料において使用されている「当社製品」とは、注 1 において定義された当社の開発、製造製品をいいます。 
 

(Rev.4.0-1  2017.11) 
 

本社所在地  お問合せ窓口 
〒135-0061 東京都江東区豊洲3-2-24（豊洲フォレシア） 

www.renesas.com 

 弊社の製品や技術、ドキュメントの最新情報、最寄の営業お問合せ窓

口に関する情報などは、弊社ウェブサイトをご覧ください。 

www.renesas.com/contact/ 

商標について   
ルネサスおよびルネサスロゴはルネサス エレクトロニクス株式会社の

商標です。すべての商標および登録商標は、それぞれの所有者に帰属

します。 
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